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1 Introduction 

CVDSim is aimed at efficient and predictive modeling of crystal growth by Chemical 
Vapor Deposition (CVD) processes. The tool is largely oriented to engineers and 
researchers working in the field of CVD of electronic materials and does not require 
expertise in Computational Fluid Dynamics from users. The unique features of the tool 
are built-in reactor geometries and chemical models combined with simple and 
convenient Graphical User Interface (GUI), which works in "grower-friendly" terms 
similar to those used in real reactor operation, minimizing the possible errors and saving 
user time needed to set-up the problem. 
 
CVDSim – Nitride Edition incorporates models of GaN, AlGaN, AlN, and InGaN growth 
in Aixtron Planetary Reactor, Aixtron AIX 200/4 RF-S reactor, and Close-Coupled 
Showerhead (CCS) reactors. It can be run on IBM-compatible computers under 
Windows 2000/XP. The minimum recommended hardware configuration is Pentium III – 
1 GHz, RAM 512Mb, and 1024×768 display resolution. 

2 CVDSim – Nitride Edition Installation and 
Licensing 

The startup package contains compressed file CVDSim-NE.zip with CVDSim – Nitride 
Edition installer. Unpack the archive to a temporary folder, run the installer and follow 
the instructions. After the installation the destination folder should contain: 

• main executable file gui.exe, implementing the graphical user interface, and auxiliary 
dynamically linked libraries qt-mt323.dll and qwt.dll; 

• solver executable file cvdsim_ne_solver.exe; 

• HASP HL Remote Update System executable file hasprus.exe; 

• this user manual user_manual.pdf; 

• end-user license agreement license.pdf; 

• HASP HL installation manual hasp_hl_manual.pdf; 

• HASP Configuration subfolder with sample HASP configuration file nethasp.ini; 

• grids subfolder with reactor geometries; 

• examples subfolder containing files with sample CVDSim projects. 
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To remove CVDSim – Nitride Edition from your computer go to the Programs folder of 
Start menu, select Uninstall item in the STR Inc/CVDSim – Nitride Edition program 
group, and follow the instructions. 
 
CVDSim – Nitride Edition will not work without a license. The licensing procedure is 
described in hasp_hl_manual.pdf. The user can contact STR by e-mail CVDSim-
support@str-soft.com if any problem arises. 

3 CVDSim – Nitride Edition Operation 

The typical use of CVDSim – Nitride Edition includes several stages: 

• Starting the CVDSim GUI by running gui.exe from the installation folder or other 
location. The user should make sure that files qt-mt323.dll, qwt.dll, 
cvdsim_ne_solver.exe and subfolder grids are located in the same folder as gui.exe. 

• Creating new simulation (see  3.1) or, alternatively, loading simulation settings saved 
earlier (see  3.2). 

• Adjusting relevant process conditions (see  3.3). 

• Setting CVDSim solver parameters (see  3.4). 

• Running the computation (see  3.5) or, alternatively, saving simulation settings to a 
file (see  3.6). 

• Exiting the CVDSim GUI (see  3.7). 

3.1 Creating New Simulation 

The New Simulation dialog (see Fig. 1) is activated automatically when CVDSim GUI 
starts. This dialog can also be invoked by selecting New item of the File menu (see  4.2), 
pressing New Simulation button  on the toolbar (see  4.3), or activating keyboard 
shortcut Ctrl+N (see  4.5). 
 
The user can select one of the reactor geometries to be modeled from the drop-down 
list Reactor Type and assign a name to the new simulation (edit field Simulation Name). 
Current version of CVDSim – Nitride Edition supports five reactor geometries: 6×2" 
Planetary Reactor, 3×2" CCS reactor, 6×2" CCS reactor, 19×2" CCS reactor, and AIX 
200/4 RF-S reactor (see Fig. 2). The simulation name can be an arbitrary combination 
of lower and upper case English letters, decimal digits, points, underscore symbols, 
percent, equals, plus and minus signs. The user can leave Simulation Name field empty 
and enter simulation name later, when saving the simulation (see  3.6). 

mailto:CVDSim-support@str-soft.com?subject=CVDSim%20-%20Nitride%20Edition%20licensing%20problems
mailto:CVDSim-support@str-soft.com?subject=CVDSim%20-%20Nitride%20Edition%20licensing%20problems
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Fig. 1 

 
Fig. 2 

The entered data can be submitted by pressing Accept button, which gives the user to 
set up a new simulation (see  3.3). The input can be rejected via Cancel button if the 
user is going to load simulation settings from file (see  3.2) or return to the previous 
state. 

3.2 Loading Simulation Settings From File 

The Load Simulation Settings dialog (see Fig. 3) can be invoked by selecting Load item 
of the File menu (see  4.2), pressing Load Simulation Settings button  on the toolbar 
(see  4.3), or activating keyboard shortcut Ctrl+L (see  4.5). If previous simulation is 
loaded, the user will be prompted to save it to file (see  3.6). 
 
The Load Simulation Settings dialog is a standard "File open" dialog, which accepts files 
with the extension "csg" (CVDSim GUI files). However, the GUI does not automatically 
append ".csg" to the filename entered by the user, so it is possible to load settings from 
a file with arbitrary extension. If file selected in the dialog is not a CVDSim GUI file or is 
a corrupted CVDSim GUI file, one of the messages shown in Fig. 4 will be displayed. In 
both cases the user will be dropped back to the main GUI window (see  4.1). 
 
After loading the simulation settings the user proceeds with editing model options (see 
 3.3) and solver parameters (see  3.4). The GUI also tries to locate previous results and 
residuals for the loaded file. If the results are available, GUI shows them on the Results, 
Deposits, and 2D Results tabs (see  4.4). 
 
NOTE. To load existing simulation immediately after GUI start, the user can press 
Cancel in the New Simulation dialog and follow the above procedure. 
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Fig. 3 

  
Fig. 4 

3.3 Adjusting Model Options 

Model options are located on the two tabs of the main CVDSim GUI window (see  4.1). 
Gas flow rates at reactor inlet(s) are set on the Flow Rates tab (see  4.4). Operation 
conditions as well as optional processes to be accounted for are set on the Model 
Options tab (see  4.4). These settings are partially different for the Planetary Reactor 
(specific settings are described in  3.3.2), for the CCS reactors (specific settings are 
described in  3.3.3), and for the AIX 200/4 RF-S reactor (specific settings are described 
in  3.3.4). Some options related to bubblers are available in the Bubbler Configuration 
dialog (described in  3.3.5). Temperature profiles are tuned in the Configure Ceiling 
Temperature, Configure Bottom Temperature, and Configure Wall Temperature dialogs 
(described in  3.3.6,  3.3.7 and  3.3.8). 

3.3.1 Common Options 

There are four materials available in the main drop-down list of the Material section in 
CVDSim – Nitride Edition: GaN, AlGaN, AlN, and InGaN (see Fig. 5). TMGa is the only 
MO precursor for GaN, TMAl is the MO precursor for AlN, while AlGaN is grown from 
TMGa and TMAl. InGaN can be grown using two different metalorganic precursor sets: 
TMGa/TMIn and TEGa/TMIn. The MO precursor set for InGaN is selected in the 
Chemical Model drop-down list of the Material section (see Fig. 6). There are also two 
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chemistry models available for AlGaN modeling: AlGaN_QT and AlGaN_Kinetic (see 
Fig. 7). 

 
Fig. 5 

 
Fig. 6 

 
Fig. 7 

 

 
Fig. 8 

The flow rates of the MO precursors are defined in the MO Precursors section. The 
contents of this section changes according to material (and chemical model) selected, 
presenting a separate subsection for every MO precursor used (see Fig. 8 for GaN, Fig. 
9 for AlGaN, Fig. 10 for AlN, Fig. 11 for InGaN_TMGa, and Fig. 12 for InGaN_TEGa). It 
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is possible to define MO flow rates via carrier gas flow through the bubbler or enter them 
explicitly. The user can switch between these two variants by toggling Use Bubbler 
checkboxes, which work independently for each MO precursor. Checking Use Bubbler 
adds one more edit box for Bubbler Flow Rate and Configure Bubbler button to the 
respective subsection of the MO Precursors section and disables MO Flow Rate edit 
box (compare top/bottom parts of Fig. 8–Fig. 12). Unchecking Use Bubbler returns 
section layout to the previous state. 

 

 
Fig. 9 

 

 
Fig. 10 

The value entered in the Bubbler Flow Rate edit box (flow rate of the carrier gas passing 
through the bubbler) is automatically recalculated into MO flow rate. The recalculated 
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flow rate is displayed in the disabled MO Flow Rate edit box (here, MO stands for 
TMGa, TMAl, TMIn, or TEGa). When Use Bubbler option is being turned on, the carrier 
gas flow rate is recalculated from the MO flow rate using inverse algorithm, so that MO 
flow rate does not change. Pressing the Configure Bubbler button brings the user to the 
bubbler configuration dialog, which allows setting bubbler conditions and fine tuning of 
the algorithm used to recalculate MO flow rate (see  3.3.5 for detailed description of the 
dialog). 

 

 
Fig. 11 

 

 
Fig. 12 

MO species flow rates entered in the edit boxes TMGa Flow Rate, TMAl Flow Rate, 
TMIn Flow Rate, and TEGa Flow Rate can be specified in sccm or µmol/min, depending 
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on the item selected in the drop-down list located next to the respective edit box. The 
numbers displayed in the edit boxes are automatically recalculated on every change of 
the flow rate units. The flow rate unit selection works even when primary edit box is 
disabled, i.e. when MO flow rate is recalculated from the bubbler flow rate. The 
minimum acceptable flow rate for the metalorganic precursors is 10-15 sccm 
independently of the unit selected. 
 
NOTE. TMAl flow rate represents mono-TMAl, not (TMAl)2. 
 
The only hydride precursor is ammonia, which is available for all the materials. NH3 flow 
rate is defined in the NH3 subsection of the Hydride Precursors section (see Fig. 13) 
and is required to exceed the value of 10-15 slm. 
 
NOTE. The bubbler flow rates are measured in sccm, while the flow rate of NH3 is 
measured in slm. 

 
Fig. 13 

The Common subsection of the section Process Parameters (see Fig. 14) includes the 
total pressure in the reactor represented by the edit box Pressure and the temperature 
of the upper surface of the substrate (combobox Satellite T/Susceptor T). The 
temperature can be either constant or profile configured in Configure Bottom 
Temperature dialog invoked by pressing More… button (see  3.3.7). 
 
NOTE. The substrate temperature is measured in degrees centigrade (Celsius). 

 
Fig. 14 

Pressure can be specified in torr or mbar, depending on the item selected in the drop-
down list located next to the edit box Pressure. The number displayed in the edit box is 
automatically recalculated on every change of the pressure unit. The pressure is 
required to be positive independently of the unit selected, the temperature is supposed 
to be higher than zero degrees centigrade. 
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3.3.2 Planetary Reactor 

Two reactor inlets of the Planetary Reactor are used for separate supply of hydride 
precursor (ammonia) and metalorganic precursors (one or two species, depending on 
the material grown) diluted in carrier gases (see Fig. 90 in  Appendix B). The flow rates 
of the carrier gases injected to the reactor (H2, N2, or both) through the two inlets can be 
set independently in the Carrier Gas section (see Fig. 15). The total carrier gas flow for 
every inlet must exceed the minimum value of 10-15 slm. Naturally, the numbers entered 
in all edit boxes should be non-negative. 
 
NOTE. N2 is the only carrier gas available for the InGaN material system. 

 
Fig. 15 

The section Process Parameters for the Planetary Reactor (see Fig. 16) additionally 
includes the temperatures of the external surface of the ceiling, top surface of the 
central disc, and top surface of the platform (combobox Ceiling T and edit boxes Disc T 
and Platform T). The temperature of the bottom surface of the ceiling is computed by 
the solver. Ceiling temperature can be either constant or profile configured in Configure 
Ceiling Temperature dialog invoked by pressing respective More… button (see  3.3.6). 
The disc and platform temperatures are always profiles configured in Configure Bottom 
Temperature dialog invoked by pressing respective More… buttons (see  3.3.7). All the 
temperatures are supposed to be higher than zero degrees centigrade. 
 
NOTE. The flow rates of carrier gases are measured in slm, and the temperature is 
measured in degrees centigrade (Celsius). 

 
Fig. 16 

The Reference Species (see Fig. 17) is used for providing species conservation: the 
solver calculates the mass fraction of this species as 1 minus the sum of the remaining 
species mass fraction. Default reference species is H2. N2 is recommended to be 
selected when the carrier gas is a H2/N2 mixture or pure N2. In the latter case, a small H2 
flowrate (10-10 should be enough) at any inlet is required for smooth convergence. There 
are also four Options represented by checkboxes (see Fig. 17) which control the Gravity 
effects, account of material losses due to Particles formation in the gas bulk, the Wafer 
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Deposition (material growth on the substrate), and parasitic Wall Deposition on the other 
reactor walls. The latter option can be switched on only when the Wafer Deposition 
option is checked. Parasitic deposition in AlGaN, AlN, GaN, and InGaN growth systems 
automatically switches to primary material growth if local wall temperature is above 
500 °C. 
 
NOTE. N2 is the only reference species available for the InGaN material system. 

 
Fig. 17 

3.3.3 CCS Reactors 

Both hydride precursor (ammonia) and metalorganic precursors are supplied to the 
reactor through the same inlet as the carrier gases (see Fig. 86 in  Appendix B). Flow 
rates of the carrier gases injected to the CCS reactors (H2, N2, or both) can be set in the 
Carrier Gas section (see Fig. 18). The total flow rate of the carrier gases must exceed 
the minimum value of 10-15 slm. Naturally, the numbers entered in all boxes should be 
non-negative. 
 
NOTE. N2 is the only carrier gas available for the InGaN material system. 

 
Fig. 18 

The section Process Parameters for the CCS reactors (see Fig. 19) additionally includes 
the temperature of the external reactor wall (combobox Wall T), the temperature of the 
flange (edit box Flange T), and the substrate rotation rate (edit box Rotation Rate). Wall 
temperature can be either constant or profile configured in Configure Wall Temperature 
dialog invoked by pressing respective More… button (see  3.3.8). The temperatures are 
supposed to be higher than zero degrees centigrade. The rotation rate can be positive 
or negative, since the exact rotation direction is insignificant within axisymmetric 
problem formulation. 
 
NOTE. The flow rates of carrier gases are measured in slm, the rotation rate is 
measured in rpm, and the temperatures are measured in degrees centigrade (Celsius). 
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Fig. 19 

The Reference Species is used for providing species conservation: the solver calculates 
the mass fraction of this species as 1 minus the sum of the remaining species mass 
fraction. Default reference species is H2. N2 is recommended to be selected when the 
carrier gas is a H2/N2 mixture or pure N2. In the latter case, a small H2 flowrate (10-10 
should be enough) at any inlet is required for smooth convergence. There are also three 
Options represented by checkboxes (see Fig. 20) which control the Gravity effects, 
account of material losses due to Particles formation in the gas bulk and the Wafer 
Deposition (material growth on the substrate). 
 
NOTE. N2 is the only reference species available for the InGaN material system. 

 
Fig. 20 

3.3.4 AIX 200/4 RF-S Reactor 

Two reactor inlets of the AIX 200/4 RF-S reactor are used for separate supply of hydride 
precursor (ammonia) and metalorganic precursors (one or two species, depending on 
the material grown) diluted in carrier gases (see Fig. 91 in  Appendix B). The flow rates 
of the carrier gases injected to the reactor (H2, N2, or both) through the two inlets can be 
set independently in the Carrier Gas section (see Fig. 21). The total carrier gas flow for 
every inlet must exceed the minimum value of 10-15 slm. Naturally, the numbers entered 
in all edit boxes should be non-negative. 
 
NOTE. N2 is the only carrier gas available for the InGaN material system. 
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Fig. 21 

The section Process Parameters for the AIX 200/4 RF-S reactor (see Fig. 22) 
additionally includes the temperature of the cooling tube (edit box Cooling Tube T) and 
the width of the reactor (edit box Reactor Width). The temperature is supposed to be 
higher than zero degrees centigrade. The width is read-only and provided for user 
reference. 
 
NOTE. The flow rates of carrier gases are measured in slm, the reactor width is 
measured in millimeters, and the temperature is measured in degrees centigrade 
(Celsius). 

 
Fig. 22 

 
Fig. 23 

The Reference Species is used for providing species conservation: the solver calculates 
the mass fraction of this species as 1 minus the sum of the remaining species mass 
fraction. Default reference species is H2. N2 is recommended to be selected when the 
carrier gas is a H2/N2 mixture or pure N2. In the latter case, a small H2 flowrate (10-10 
should be enough) at any inlet is required for smooth convergence. There are also four 
Options represented by checkboxes (see Fig. 23) which control the Gravity effects, 
account of material losses due to Particles formation in the gas bulk, the Wafer 
Deposition (material growth on the substrate), and parasitic Wall Deposition on the other 
reactor walls. The latter option can be switched on only when the Wafer Deposition 
option is checked. Parasitic deposition in AlGaN, AlN, GaN, and InGaN growth systems 



 
 

 

 
14 

automatically switches to primary material growth if local wall temperature is above 
500 °C. 
 
NOTE. N2 is the only reference species available for the InGaN material system. 

3.3.5 Bubbler Configuration Dialog 

Each MO species flow rate can be computed using bubbler instead of providing exact 
value. Carrier gas flow rate is the only bubbler parameter displayed on the main GUI 
window. Other parameters as well as parameters of the flow rate recalculation algorithm 
are placed in a separate dialog. The Bubbler Configuration dialog for the particular MO 
species can be invoked by pressing the Configure Bubbler button located in the 
respective subsection of the MO Precursors section. 
 
There are four bubbler configuration dialogs, by the number of MO species. The dialogs 
are generally identical, differing in number of the available flow rate recalculation 
algorithms and their parameters. This section describes TMGa Bubbler Configuration 
dialog only. 
 
The first section of the dialog contains bubbler conditions: Flow Rate of the carrier gas 
passing through the bubbler, bubbler Pressure and Temperature. Edit box Flow Rate 
duplicates edit box Bubbler Flow Rate located on the main GUI window. 
 
NOTE. The flow rate of carrier gas is measured in sccm, the pressure is measured in 
mbar, and the temperature is measured in degrees centigrade (Celsius). 

 
Fig. 24 

The second section of the dialog controls the approximation used for the computation of 
the TMGa partial pressure, which is required to compute TMGa flow rate. The exact 
number of items listed in the Approximation combobox depends on MO species 
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considered; however, there is always Custom item which allows the user to specify 
custom approximation coefficients. The data for the approximation named O.Kayser et 
al are taken from paper O.Kayser, H.Heinecke, A.Brauers, H.Luth, P.Balk, Chemtronics, 
Volume 3, Issue 2, June 1988, Pages 90-93. The data for the approximation named 
Rohm and Haas are taken from the web site of "Rohm and Haas Electronic Materials" 
(http://electronicmaterials.rohmhaas.com/businesses/micro/metalorganics/vapor.asp?ca
id=291). 
 
The third section of the dialog displays TMGa Flow Rate, along with unit selection 
combobox. This part of the dialog also duplicates controls located on the main GUI 
window. 
 
Pressing OK button applies all changes made in the dialog and propagates them in the 
main GUI window. Pressing Cancel button discards all changes made in the dialog. 

3.3.6 Configure Ceiling Temperature Dialog 

Ceiling temperature can be set as profile instead of providing single constant value. The 
constant value is the only ceiling parameter displayed on the main GUI window; profile 
parameters are placed in a separate dialog. The Configure Ceiling Temperature dialog 
can be invoked by pressing the More… button located next to Ceiling T combobox in the 
Process Parameters section. 

 
Fig. 25 

The dialog has only one section, where the user can set constant ceiling temperature or 
select the number of profile points and define their temperatures (see Fig. 25). The 
profile can have 2, 3, 5, or 9 regular points. The point coordinates are parametric values 
varying from 0 to 1 along reactor radius (Fig. 26). When profile has more than 2 points, 
it is possible to switch between linear and spline profile interpolation by (un)checking 
respective Spline checkbox. Pressing OK button applies all changes made in the dialog 

http://electronicmaterials.rohmhaas.com/businesses/micro/metalorganics/vapor.asp?caid=291
http://electronicmaterials.rohmhaas.com/businesses/micro/metalorganics/vapor.asp?caid=291
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and propagates them in the main GUI window. Pressing Cancel button discards all 
changes made in the dialog. 

 
Fig. 26 

3.3.7 Configure Bottom Temperature Dialog 

Substrate temperature can be set as profile instead of providing single constant value. 
The constant value is the only substrate parameter displayed on the main GUI window; 
substrate profile parameters as well as disc and platform profile parameters are placed 
in a separate dialog. The Configure Bottom Temperature dialog can be invoked by 
pressing one of the More… buttons located next to Satellite T/Susceptor T, Disc T, or 
Platform T controls in the Process Parameters section. 
 
The dialog for the CCS and AIX 200/4 RF-S reactors has only one section (see Fig. 27). 
The dialog for the Planetary Reactor has four sections, where the user can set constant 
satellite temperature or select the number of profile points and define their temperatures 
(see Fig. 28). The profiles can have 2, 3, 5, or 9 regular points. The point coordinates 
are parametric values varying from 0 to 1 along reactor radius or reactor length. The 
sections are ordered from reactor center to periphery. When profile has more than 2 
points, it is possible to switch between linear and spline profile interpolation by 
(un)checking respective Spline checkbox. Pressing OK button applies all changes made 
in the dialog and propagates them in the main GUI window. Pressing Cancel button 
discards all changes made in the dialog. 
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Fig. 27 

 
Fig. 28 
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3.3.8 Configure Wall Temperature Dialog 

Wall temperature can be set as profile instead of providing single constant value. The 
constant value is the only wall parameter displayed on the main GUI window; wall profile 
parameters are placed in a separate dialog. The Configure Wall Temperature dialog can 
be invoked by pressing More… button located next to Wall T combobox in the Process 
Parameters section. 
 
The dialog has two sections, where the user can set wall temperature for the wall 
section above susceptor level and for the wall section below susceptor level as constant 
values or select the number of profile points and define their temperatures (see Fig. 29). 
The profiles can have 2, 3, 5, or 9 regular points. The point coordinates are parametric 
values varying from 0 to 1 along reactor height. When profile has more than 2 points, it 
is possible to switch between linear and spline profile interpolation by (un)checking 
respective Spline checkbox. Pressing OK button applies all changes made in the dialog 
and propagates them in the main GUI window. Pressing Cancel button discards all 
changes made in the dialog. 

 
Fig. 29 

3.4 Setting Solver Parameters 

Solver configuration information is located on the Solver Settings tab (see  4.4) of the 
main CVDSim GUI window (see  4.1). 
 
The user can select basic process priority for the solver from the drop-down list in the 
General section (see Fig. 30). There are three options available under Windows 2000 
and higher: Low, Below Normal, and Normal. Below Normal item is not available under 
Windows 98/ME/NT. Default priority is Below Normal (when available) or Low. 
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Fig. 30 

The user can instruct CVDSim solver to start computations from scratch by selecting 
New Simulation item from the drop-down list in the Initial Conditions section (see Fig. 
31). This option requires specifying an initial temperature in the edit box Temperature 
and selecting initial species mixture from two items of the Gas Mixture combobox. 
Carriers & Precursors option provides initial gas mixture as flowrate-weighted average 
of all species supplied into the reactor, Carriers Only option similarly accounts for the 
flowrates of the carrier gases only. 

 
Fig. 31 

 
Fig. 32 

 
Fig. 33 
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It is also possible to start simulation from computation data previously saved in rst-file 
by selecting Restart item of the drop-down list. This option requires name of the file to 
restart from (see Fig. 32). Name of the restart file cannot be typed manually since 
editbox Restart File is read-only, so the user has to select restart file through Select 
Restart File dialog, which is invoked by pressing … button (see Fig. 33). This is a 
standard "File open" dialog, which accepts files with the extension "rst" (CVDSim 
Restart files). However, the GUI does not automatically append ".rst" to the filename 
entered by the user, so it is possible to restart from a file with arbitrary extension. 
 
The Continue item of the drop-down list does not require any additional input and allows 
seamless continuation of the interrupted computations (see Fig. 34). This option 
assumes availability of respective rst- and res-files. 
 
NOTE. The GUI does not save the name of the restart file into csg-file. 

 
Fig. 34 

The computations normally stop when the convergence is reached or the maximum 
number of iterations has been performed. The first criterion is not controlled by the user, 
but the user can specify the iterations limit in the Stop Criteria section (see Fig. 35). The 
iterations for the Continue mode include the iterations performed before the interruption 
of the computations, so the actual number of iterations to be performed is the difference 
between the iteration limit and the number of iterations performed before interruption of 
the computations. 

 
Fig. 35 

 
Fig. 36 
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Computation convergence can be controlled by adjusting relaxation and inertial 
parameters of the numerical solution in the section Computational Parameters (see Fig. 
36). 
 
Most problems should converge if the initial values of the relaxation and inertial factors 
are used. Indeed, there can be problems that would not converge with these settings. 
See  Appendix A for recommendations on solver settings for different problems. The 
user can also refer to several examples of solver settings provided in the examples 
subfolder of the installation folder of CVDSim. 
 
The restart data and computation results can be written to files either on regular basis or 
at the end of the simulation, depending on the selected item of the drop-down list in the 
Output section. The Specified Interval option (see Fig. 37) allows the user to set interval 
(the number of iterations) between consecutive saves. The End of Simulation option 
instructs CVDSim solver to save restart data and computation results only once, after 
normal termination of the computation. In the latter case, if the computation is not 
terminated normally (e.g. due to power interruption, OS shutdown) or stopped using 
Stop option, the results and restart data are not saved. The user can additionally select 
variables to be saved for 2D visualization by marking respective checkboxes in the 2D 
Variables subsection of the Output section. 

 
Fig. 37 

3.5 Running the Computation 

3.5.1 Starting and Stopping the Computation 

To start computation the user can select Run item of the Run menu (see  4.2), press 
Run Simulation button  on the toolbar (see  4.3), or activate keyboard shortcut 
Ctrl+Return (see  4.5). CVDSim GUI checks gas flow rates entered on the Flow Rates 
tab (see  4.4) before starting the solver. If any of the flow rates does not exceed the 
threshold, corresponding error message is displayed (see Fig. 38) and the solver is not 
started. 
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Fig. 38 

Other operation conditions entered on the Model Options tab (see  4.4) and initial 
temperature are checked for general physical validity as well. For example, the pressure 
is supposed to be positive, and all the temperatures are supposed to be positive if 
measured in degrees centigrade (Celsius). If any of the checks is failed, corresponding 
error message is displayed (see Fig. 39) and the solver is not started. However, GUI 
does not ensure the values are suitable for the particular CVD process. 
 
NOTE. The GUI does not check the quantities that are not involved in the current 
simulation. 
 
Finally, the GUI examines relaxation and inertial factors entered on the Solver Settings 
tab (see  4.4). The inertial factors are supposed to be non-negative, and the relaxation 
factors should lie in the range from zero to unity (see Fig. 40). 
 
After passing all the consistency checks, GUI saves current simulation settings (this 
situation is identical to saving settings manually, so the user may need to enter the 
name of the CVDSim GUI file, see  3.6 for details). 
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Fig. 39 

  
Fig. 40 

Next, GUI exports settings to a CVDSim solver input file (a file with extension "in") and 
copies geometry description file (a file with extension "fsg") to the project file (a file with 
extension "csg") location and starts the solver. CVDSim solver creates several 
additional files in the same location. The residuals are logged to a file with extension 
"res" in a text format compatible with Tecplot. The restart data are written to a binary file 
with extension "rst". Solver errors and warnings are logged to a file with extension "err". 
The data to be displayed on the Results tab (see  4.4) of the main GUI window (see  4.1) 
are dumped to a file with extension "dmp". The data to be displayed on the Deposits tab 
(see  4.4) of the main GUI window (see  4.1) are dumped to a file with extension "dmd". 
The data fields to be displayed on the 2D Results tab (see  4.4) of the main GUI window 
(see  4.1) are saved to a binary file with extension "dst". A file with extension "loc" is 
used to indicate that a problem with respective name is submitted in the current 
location, preventing other solver instances from using this name. This file is 
automatically deleted when the solver finishes its work. 
 
NOTE. The names of the intermediate and output files created by the solver are derived 
from the name of the CVDSim solver input file. 
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Fig. 41 

If CVDSim GUI is unable to find/to start the CVDSim solver executable file or if CVDSim 
solver exits with error one of the error messages shown in Fig. 41 is displayed. 
 
The toolbar buttons New Simulation, Load Simulation Settings, Save Simulation 
Settings, Save Simulation Settings As …, Export .IN File …, and Run Simulation and 
menu items New, Load, Save, Save As…, Export .IN…, and Run are disabled as soon 
as solver starts, while toolbar buttons Stop Simulation, Save & Stop Simulation, Save & 
Continue Simulation and menu items Stop, Save&Stop, Save&Continue are enabled. In 
particular, the user cannot submit more than one problem from single GUI instance 
without stopping the previously started computations. 
 
The user can terminate the computation before convergence is reached or the 
maximum number of iterations is performed by selecting Save&Stop item of the Run 
menu (see  4.2), pressing Save & Stop Simulation button  on the toolbar (see  4.3), or 
activating keyboard shortcut Ctrl+End (see  4.5). This option instructs the solver to save 
the results and restart data just before the termination. If the results of the unfinished 
computation are of no interest, the user can terminate the computation by selecting Stop 
item of the Run menu (see  4.2), pressing Stop Simulation button  on the toolbar (see 
 4.3), or activating keyboard shortcut Ctrl+Del (see  4.5). The computations can also be 
terminated indirectly, by exiting the GUI (see  3.7). The user can instruct the solver to 
save the results and restart data at arbitrary iteration by selecting Save&Continue item 
of the Run menu (see  4.2), pressing Save & Continue Simulation button  on the 
toolbar (see  4.3), or activating keyboard shortcut Ctrl+Home (see  4.5). 
 
NOTE. The termination of the computation can take some time, as the solver may be 
unable to stop instantly, e.g. during file write. 
 
CVDSim GUI displays solver output in the Console Output section (see Fig. 42) of the 
Output tab (see  4.4) of the main GUI window (see  4.1). The output of the solver is, 
mostly, a table of residuals for temperature, radiation, flow velocity components, 
pressure, chemical species and particles related variables, deposition rate, and crystal 
composition. The minor part of the solver output is solver version, license status, and 
error and warning messages duplicated in the err-file. 
 
There are two buttons at the bottom of the Console Output section. If the solver is not 
running the output window can be cleared by pressing Clear button. The contents of the 
output window can be saved into a file by pressing Save button and invoking Save 
Console Output As… dialog (see Fig. 43). This is a standard "File save" dialog, which 
saves files with the extension "log" only. If filename entered in the dialog does not end 
with ".log", the GUI will automatically append ".log" to the user input before saving the 
file. 



 
 

 

 
25 

 
Fig. 42 

 
Fig. 43 

3.5.2 1D Results of the Computation 

The principal results of the computations are presented graphically in the Profiles 
section of the Results tab (see  4.4) as radial distributions of the crystal growth rate and 
composition (for ternary compounds) or surface coverage (for GaN); the mean values of 
the quantities are displayed in the Averaged Values section, the values of the quantities 
at the substrate (satellite) center are displayed in the Center Values section (see Fig. 
44–Fig. 47). Also relative standard deviation of the growth rate distribution is available in 
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the Averaged Values section for angle averaged profiles; for instant profiles -1 is used to 
fill the space. 
 
The instant profiles computed for the CCS reactors are plotted as is, without any post-
processing (see Fig. 44). The instant profiles for the Planetary Reactor are additionally 
averaged with account for the satellite rotation, producing symmetric distributions shown 
in Fig. 45. The instant profiles for the AIX 200/4 RF-S reactor are rotationally averaged 
as well (see Fig. 46). Instant profiles of the surface coverage are not averaged; constant 
distribution at -1 level is used to fill the space (see Fig. 47). Either averaged profiles and 
averaged values or instant profiles and center values can be plotted at a time. Two 
options of the Show Results as… section define which data set is plotted on the chart 
(see Fig. 45–Fig. 47). The mean values of the growth rate and composition are not 
arithmetic means of the respective profile points, but weighted means computed with 
respect to the substrate area. The center values for the CCS reactors are taken from the 
left edge of the profile. The center values for the Planetary Reactor and AIX 200/4 RF-S 
reactor are taken from the middle point of the instant profile. 
 
The lines on the profiles plot can be hidden by clicking the respective legend item with 
mouse or by selecting legend item with keyboard and pressing Space. The legend item 
representing hidden line is shown on the legend without line sample. Hidden profile line 
can be shown back by clicking the same legend item again (or selecting this item with 
keyboard and pressing Space again). The profiles plot is rescaled automatically after 
turning its lines on and off. 
 
The visibility status of the profiles lines is remembered till the moment the user creates a 
new project, loads another project, or saves current project under different name. Thus, 
updating the plot will not discard the status of the profile lines. 

 
Fig. 44 
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Fig. 45 
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Fig. 46 
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Fig. 47 

The Update button on the Results tab (see  4.4) is disabled by default. It becomes active 
only after the solver performs first iteration and, thus, produces profiles for the first time. 
The user can update data manually, by pressing the button, or mark Auto checkbox and 
let the GUI update data automatically. For user reference GUI shows the iteration, at 
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which profiles were last read, in the titles of the Averaged Values and Profiles sections. 
Pressing the Update button may produce error message if GUI cannot find the dmp-file 
with profiles (see Fig. 48). This is possible if the solver has not created the file for some 
reason or if the file has been deleted by a third program/person. 

 
Fig. 48 

When the profiles data are loaded into the GUI, Copy Image, Export Image… and 
Export Data… buttons on the Results tab are enabled. The picture can be copied to 
system clipboard by pressing the first button. Pressing the second button invokes popup 
menu with available image file formats (see Fig. 49). After selecting the image format 
the user proceeds to Export Profiles to Image File dialog (see Fig. 50). It is a standard 
"File save" dialog, which saves files with extension "bmp", "png", "ppm", or "xpm", 
depending on the image format. File name suggested in the dialog is derived from the 
in-file name and includes the iteration profiles were read at. If filename entered in the 
dialog does not end with expected extension, the GUI will automatically append it to the 
user input before saving the file. 

 
Fig. 49 

 
Fig. 50 
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Pressing the Export Data… button invokes popup menu with available text file formats 
(see Fig. 51). After selecting the file format the user proceeds to Export Profiles to Text 
File dialog (see Fig. 52). It is a standard "File save" dialog, which saves files with 
extension "csv" (comma separated values), "dat" (tab separated values), "plt" (Tecplot 
compatible format), or “xml” (Microsoft Excel compatible XML format), depending on the 
file format. File name suggested in the dialog is derived from the in-file name and 
includes the iteration profiles were read at. If filename entered in the dialog does not 
end with expected extension, the GUI will automatically append it to the user input 
before saving the file. 

 
Fig. 51 

 
Fig. 52 

Additional results of the computations are presented graphically in the Deposits section 
of the Deposits tab (see  4.4) as profiles of the deposition rate and temperature at the 
reactor bottom and profiles of the parasitic deposit growth rate and temperature at the 
reactor ceiling (if available). Deposition rate profiles at the reactor bottom include instant 
growth rate profiles shown in Fig. 44–Fig. 46. Either bottom or ceiling profiles can be 
plotted at a time. Two options of the Show Profiles at… section define which data set is 
plotted on the chart for the Planetary Reactor and AIX 200/4 RF-S reactor (see Fig. 53 
and Fig. 54). Only bottom profiles are available for the CCS reactors (see Fig. 55). 
 
The Update button on the Deposits tab (see  4.4) is disabled by default. It becomes 
active only after the solver performs first iteration and, thus, produces deposit profile for 
the first time. The user can update data manually, by pressing the button, or mark Auto 
checkbox and let the GUI update data automatically. For user reference GUI shows the 
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iteration, at which data were last read, in the title of the Deposits section. Pressing the 
Update button may produce error message if GUI cannot find the dmd-file with profiles 
(see Fig. 56). This is possible if the solver has not created the file for some reason or if 
the file has been deleted by a third program/person. 

 

 
Fig. 53 
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Fig. 54 
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Fig. 55 

 
Fig. 56 

 
Fig. 57 

When the deposits data are loaded into the GUI, Copy Image, Export Image… and 
Export Data… buttons on the Deposits tab are enabled. The picture can be copied to 
system clipboard by pressing the first button. Pressing the second button invokes popup 
menu with available image file formats (see Fig. 57). After selecting the image format 
the user proceeds to Export Deposits to Image File dialog (see Fig. 58). It is a standard 
"File save" dialog, which saves files with extension "bmp", "png", "ppm", or "xpm", 
depending on the image format. File name suggested in the dialog is derived from the 
in-file name and includes the iteration deposits were read at. If filename entered in the 
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dialog does not end with expected extension, the GUI will automatically append it to the 
user input before saving the file. 

 
Fig. 58 

 
Fig. 59 

 
Fig. 60 

Pressing the Export Data… button invokes popup menu with available text file formats 
(see Fig. 59). After selecting the file format the user proceeds to Export Deposits to Text 
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File dialog (see Fig. 60). It is a standard "File save" dialog, which saves files with 
extension "csv" (comma separated values), "dat" (tab separated values), "plt" (Tecplot 
compatible format), or “xml” (Microsoft Excel compatible XML format), depending on the 
file format. File name suggested in the dialog is derived from the in-file name and 
includes the iteration deposits were read at. 
 
If filename entered in the dialog does not end with expected extension, the GUI will 
automatically append it to the user input before saving the file. 

3.5.3 2D Results of the Computation 

The detailed results of the computations are presented graphically on 2D plot in the 2D 
Distributions section of the 2D Results tab (see  4.4) as 2D distributions of the main 
process variables including instant growth rate and composition (see Fig. 61). 

 
Fig. 61 

 
The Update button on the 2D Results tab (see  4.4) is disabled by default. It becomes 
active only after the solver creates 2D distributions file. The user can update data 
manually, by pressing the button, or mark Auto checkbox and let the GUI update data 
automatically. For user reference GUI shows the iteration, at which the data were last 
read, in the title of the 2D Distributions section. Pressing the Update button may 
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produce error message if GUI cannot find the dst-file with data (see Fig. 62). This is 
possible if the solver has not created the file for some reason or if the file has been 
deleted by a third program/person. 

 
Fig. 62 

When the 2D data are loaded into the GUI, Copy Image, Export Image…, Import View, 
and Export View buttons on the 2D Results tab are enabled. The picture of the 2D plot 
can be copied to system clipboard by pressing the first button. Pressing the second 
button invokes popup menu with available image file formats (see Fig. 63). After 
selecting the image format the user proceeds to Export 2D Distributions to Image File 
dialog (see Fig. 64). This is a standard "File save" dialog, which saves files with 
extension "bmp", "png", "ppm", or "xpm", depending on the image format. File name 
suggested in the dialog is derived from the in-file name and includes the iteration 2D 
fields were read at and name of the plotted variable (if Contours are enabled). If 
filename entered in the dialog does not end with expected extension, the GUI will 
automatically append it to the user input before saving the file. 

 
Fig. 63 

 
Fig. 64 
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There are several Options that control what is shown on the 2D plot (see Fig. 65). The 
user can instruct the GUI to display computational Grid used by the solver, Boundaries 
of the computational blocks, and Substrate location. Boundaries option is only 
meaningful for the Planetary Reactor and AIX 200/4 RF-S reactor, as CCS reactors 
have only one computational block. 
 
The user can control position and size of the picture shown on the 2D plot with mouse 
and keyboard. The picture can be dragged by pressing right mouse button and moving 
mouse pointer in any direction. The dragging stops when the user releases right mouse 
button. Pressing or releasing any other mouse button while moving the pointer will 
cancel the dragging. The picture can be zoomed in/out by pressing middle mouse 
button and moving mouse pointer downwards/upwards. The zooming stops when the 
user releases middle mouse button. Pressing or releasing any other mouse button while 
moving the pointer will cancel the zooming. It is also possible to zoom the picture by 
rotating mouse wheel. Current zoom (in percents) is shown in edit box Zoom located in 
a lower part of the Options section. The initial zoom factor autoselected by the GUI 
corresponds to 100% zoom. The user can type new value of the zoom in this edit box, 
or press Zoom In/Zoom Out buttons to multiply/divide current zoom by a factor of 1.5. 
Show All button resets zoom to 100% and centers the picture. 
 
NOTE. The zoom can be changed from 0.1% to 100000%. 

 
Fig. 65 

When 2D plot has keyboard focus, the picture can be moved by pressing cursor keys or 
numpad cursor keys and zoomed by pressing "+"/"-" on the numpad or Page Up/Page 
Down. The speed of dragging and zooming can be altered by holding modifier keys. 
Shift increases the speed, Ctrl decreases the speed, and Alt decreases the speed even 
more. Home key and numpad "*" are identical to Show All button. 
 
The Contours section provides controls governing the view of the contours plot (see Fig. 
66, left). The section and its contents are enabled when the Contours checkbox is 
marked. 
 
The Variable to be plotted can be selected from the drop-down list, which may include, 
depending on simulation settings, coordinates, temperature, velocity components, 
dynamic pressure, density, specific heat, conductivity, viscosity, mass and molar 
fractions of the chemical species, average particle concentration and density, surface 
material growth rates, and crystal composition (see Fig. 66, right). The user can change 
Upper and Lower Limits of the current variable in the respective edit boxes. The default 
limits for the current variable can be restored by pressing Maximize Range button. 
Variable distributions are normally plotted in the linear scale, while the user has an 
option to plot the distributions in the logarithmic scale by marking Log Scale checkbox. 
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In this case the upper and lower limits of the current variable may be adjusted by the 
GUI, as both limits should be positive to allow plotting in the logarithmic scale; the limits 
will not change back after switching to the linear scale. 

  
Fig. 66 

The color palette used for data plotting can be selected from Colormap drop-down list. 
There are four multicolored and two grayscale colormaps available (see Fig. 67). 

 
Fig. 67 

Contours legend displayed on the left part of the 2D plot is turned on/off by Legend 
checkbox. The view of the legend is configured in a separate dialog which is invoked by 
pressing Configure Legend button. There are six options in the dialog (see Fig. 68): 
display current variable and its Units (if available) in the Title above the legend; draw 
Ticks with Numbers and additional Minor Ticks without numbers at the right edge of the 
legend; show current Min and Max values below and above the legend. 

 
Fig. 68 

The Vectors section provides controls governing the view of the velocity vectors (see 
Fig. 69). The section and its contents are enabled when the Vectors checkbox is 
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marked. Current vector scale (in percents) is shown in edit box Scale. The initial scale 
autoselected by the GUI corresponds to 100% scale. The user can type new value of 
the scale in this edit box, or adjust it dynamically using slider located below the edit box. 
The length of the vectors is proportional to the local velocity magnitude; however, the 
vectors can be displayed uniformly sized by marking Uniform checkbox. 
 
NOTE. The scale can be changed from 0.1% to 100000%. 

 
Fig. 69 

The user can save all settings of the 2D plot viewer into a file and load it into others GUI 
instances to reproduce the settings, e.g. to visually compare a series of computations. 
Pressing Import View button invokes Import Viewer Settings dialog (see Fig. 70). This is 
a standard "File open" dialog, which accepts files with the extension "vsf" (CVDSim 
Viewer Settings files). However, the GUI does not automatically append ".vsf" to the 
filename entered by the user, so it is possible to load settings from a file with arbitrary 
extension. Pressing Export View button invokes Export Viewer Settings… dialog (see 
Fig. 71). This is a standard "File save" dialog, which saves files with the extension "vsf" 
only. If filename entered in the dialog does not end with ".vsf", the GUI will automatically 
append ".vsf" to the user input before saving the file. 

 
Fig. 70 
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Fig. 71 

3.5.4 Computation Convergence 

The user can inspect computation convergence on the residual charts in the Residuals 
section (see Fig. 72, top) of the Residuals tab (see  4.4) and in the Specific Residuals 
section (see Fig. 72, bottom) of the Specific Residuals tab (see  4.4). The latter chart 
displays residuals for Growth Rate and Composition; and the former chart displays all 
other residuals. The specific residuals provide general view of the convergence process, 
illustrating change of the essential simulation results in course of computations. Other 
residuals give more insight into the solution convergence, as these residuals reflect the 
internals of the solution process. 
 
NOTE. The Composition residual is always zero for GaN and AlN, as Composition is 
meaningless for these materials. 
 
The every residual plotted on the residual charts is normalized to the first non-zero 
residual value encountered. So, if the first non-zero value of the particular residual is 
about 10-20, and the typical residual value is about 10-5, the residual line will be plotted 
at a level of 10-5/10-20 = 1015. Thus, the exact level of the residual line is not of great 
importance; it is the residual drop to be traced on the charts. The residual normalization 
is performed to compact the residual lines and facilitate the identification of the worse 
converging process or parameter. The actual residual values are still shown numerically 
in the Console Output section of the Output tab (see Fig. 42). 
 
The residual lines can be hidden by clicking the respective legend item with mouse or 
by selecting legend item with keyboard and pressing Space. The legend item 
representing hidden line is shown on the legend without line sample. Hidden residual 
line can be shown back by clicking the same legend item again (or selecting this item 
with keyboard and pressing Space again). The residual plots are rescaled automatically 
after turning their lines on and off. 
 
The visibility status of the residuals lines is remembered till the moment the user creates 
a new project, loads another project, or saves current project under different name. The 
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residual charts are refreshed after these user actions and the residual data are cleared 
together with visibility status. 
 
NOTE. The residual charts are updated and rescaled automatically after every solver 
iteration. 

 

 
Fig. 72 
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3.6 Saving Simulation Settings 

The simulation settings can be saved to a file by selecting Save item of the File menu 
(see  4.2), pressing Save Simulation Settings button  on the toolbar (see  4.3), or 
activating keyboard shortcut Ctrl+S (see  4.5). If present simulation settings have no 
associated file (i.e. they were not loaded from a file or saved to a file before), the Save 
Simulation Settings As… dialog will be displayed (see Fig. 73). Otherwise, simulation 
setting will be silently saved into the associated file. 
 
The Save Simulation Settings As… dialog can also be invoked by selecting Save As… 
item of the File menu (see  4.2) or pressing Save Simulation Settings As … button  on 
the toolbar (see  4.3). This is a standard "File save" dialog, which saves files with the 
extension "csg" (CVDSim GUI files) only. GUI interprets saving simulation settings 
under different name as creation of a new project, which means that residuals and 
profiles plots are cleared after the save. If filename entered in the dialog does not end 
with ".csg", the GUI will automatically append ".csg" to the user input before saving the 
file. 

 
Fig. 73 

The user will be suggested to save current simulation settings before exiting the 
CVDSim GUI, loading simulation settings, or creating new simulation (see Fig. 74). 
Select Yes to save current simulation settings to a file. Select No to discard unsaved 
changes. Select Cancel to abort the action in progress and revert to the main GUI 
window. 
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Fig. 74 

 
Fig. 75 

Additionally, the user can export simulation settings to a CVDSim solver input file. This 
function is invoked by selecting Export .IN… item of the File menu (see  4.2), pressing 
Export .IN File … button  on the toolbar (see  4.3) or activating keyboard shortcut 
Ctrl+I (see  4.5). A standard "File save" dialog is displayed (see Fig. 75), which saves 
files with the extension "in" (CVDSim solver input files) only. If filename entered in the 
dialog does not end with ".in", the GUI will automatically append ".in" to the user input 
before saving the file. 
 
NOTE. Importing simulation settings from CVDSim solver input files is not supported. 

3.7 Exiting CVDSim GUI 

The user can exit CVDSim GUI at any moment by selecting Exit item of the File menu 

(see  4.2), pressing Exit button  on the toolbar (see  4.3), or activating keyboard 
shortcut Ctrl+Q (see  4.5). If a simulation is loaded into the GUI, the user will be 
prompted to save simulation settings to a file (see  3.6). Exiting the GUI automatically 
terminates the computations submitted from this GUI instance, so the user has to 
confirm the choice in additional dialog shown in Fig. 76. Select OK to terminate the 
computation and exit GUI. Select Cancel to revert to the main window and to keep 
simulation running. Since the solver may be forced to terminate even during file-write 
operation, the computation results can be completely lost. Thus, the Stop or Save&Stop 
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options (see  3.5) should be used to terminate the computations before exiting the GUI 
unless the computation results are of no interest for the user. 
 
NOTE. This dialog is not displayed if computations are not running. 

 
Fig. 76 

4 CVDSim GUI Overview 

4.1 Main Window 

The main window of the CVDSim GUI (see Fig. 77) contains Menu Bar (described in 
 4.2), Toolbar (described in  4.3), status bar and several tab windows, switched through 
tab selector (described in  4.4). Although the CVDSim GUI is best operated with mouse 
or other pointing device, it can be used without such device, as all the functions of the 
GUI can be accessed using keyboard or compatible device. Additionally, some 
operations have been assigned keyboard shortcuts (described in  4.5). 
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Fig. 77 

4.2 Menu Bar 

There are three menus on the menu bar, as shown in Fig. 78: File, Run, and Help. 

 
Fig. 78 

Menu File 

The items of the File menu (see Fig. 79) allow the user to create new simulation, to load 
simulation settings from an existing file, to save the current simulation settings to a file, 
and to export the settings to CVDSim solver input file. Available keyboard shortcuts are 
displayed next to the items of the menu. 
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Fig. 79 

The menu item New allows the user to create a new simulation (see  3.1). The menu 
item is duplicated by the button  (New Simulation) located on the Toolbar (see  4.3). 
 
The menu item Load allows the user to load simulation settings from an existing file in 
the CVDSim GUI format (see  3.2). The menu item is duplicated by the button  (Load 
Simulation Settings) located on the Toolbar (see  4.3). 
 
The menu item Save allows the user to write current simulation settings into the 
associated CVDSim GUI file (see  3.6). If present simulation settings have no associated 
file (i.e. they were not loaded from a file or saved to a file), the Save option will work as 
the Save As… option. The menu item is duplicated by the button  (Save Simulation 
Settings) located on the Toolbar (see  4.3). 
 
The menu item Save As… allows the user to store current simulation settings into a 
CVDSim GUI file specifying the file name manually (see  3.6). The menu item is 
duplicated by the button  (Save Simulation Settings As …) located on the Toolbar 
(see  4.3). 
 
The menu item Export .IN… allows the user to write simulation settings to a CVDSim 
solver input file (see  3.6). The menu item is duplicated by the button  (Export .IN 
File …) located on the Toolbar (see  4.3). 
 
The menu item Recent Files expands to a submenu containing up to ten projects 
opened or saved recently, with the most recent files listed first (see Fig. 80). 

 
Fig. 80 

The menu item Exit allows the user to exit the CVDSim GUI (see  3.7). The menu item is 

duplicated by the button  (Exit) located on the Toolbar (see  4.3). 
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Menu Run 

The items of the Run menu (see Fig. 81) allow the user to start computations or to stop 
them. Keyboard shortcuts are displayed next to the items of the menu. 

  
Fig. 81 

The menu item Run allows the user to start computations using current simulation 
settings (see  3.5). The menu item is duplicated by the button  (Run Simulation) 
located on the Toolbar (see  4.3). 
 
The menu item Stop allows the user to stop previously started computations before 
reaching maximum iterations or converging to the specified criterion (see  3.5). The 
menu item is duplicated by the button  (Stop Simulation) located on the Toolbar (see 
 4.3). 
 
The menu item Save&Stop allows the user to stop previously started computations 
before reaching maximum iterations or converging to the specified criterion (see  3.5) 
without losing the latest simulation results. The menu item is duplicated by the button  
(Save & Stop Simulation) located on the Toolbar (see  4.3). 
 
The menu item Save&Continue instructs the solver to save simulation results at 
arbitrary iteration and continue the computation (see  3.5). The menu item is duplicated 
by the button  (Save & Continue Simulation) located on the Toolbar (see  4.3). 
 
The three latter menu items are mutually exclusive with the New, Load, Save, Save 
As…, Export .IN…, and Run items and are never enabled simultaneously. 

Menu Help 

The items of the Help menu (see Fig. 82) allow the user to run HASP HL Remote 
Update System utility, display PDF manuals, or brief information about GUI. Available 
keyboard shortcuts are displayed next to the items of the menu. 

 
Fig. 82 

The menu item User Manual opens this user manual in application associated with PDF 
files. 
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The menu item HASP HL Manual opens HASP HL Installation Manual in application 
associated with PDF files. 
 
The menu item HASP HL RUS Utility runs HASP HL Remote Update System utility used 
for licensing. 
 
The menu item About shows brief information about CVDSim GUI (see Fig. 83). The 

menu item is duplicated by the button  (About) located on the Toolbar (see  4.3). 

 
Fig. 83 

4.3 Toolbar 

The Toolbar (see Fig. 84) contains Tool Buttons for a quick access to the frequently 
used operations. The Toolbar is dockable, it can be detached from the main CVDSim 
GUI window and moved to any desktop point. 

 
Fig. 84 

The buttons  (New Simulation),  (Load Simulation Settings),  (Save Simulation 

Settings),  (Save Simulation Settings As …),  (Export .IN File …), and  (Exit) 
completely duplicate the corresponding items of the File menu (see  4.2). The buttons  
(Run Simulation),  (Stop Simulation),  (Save & Stop Simulation), and  (Save & 
Continue Simulation) have exactly the same functionality as the corresponding items of 

the Run menu (see  4.2). The button  (About) duplicates the corresponding item of 
the Help menu (see  4.2) too. Available keyboard shortcuts are displayed in the status 
bar and in the hint shown over the toolbar button. 
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4.4 Tab Windows 

There are nine tab windows on the main GUI window: Flow Rates, Model Options, 
Solver Settings, Results, Deposits, 2D Results, Output, Residuals, and Specific 
Residuals. Only one window is visible at any moment, since these windows occupy the 
same area of the main window. Tab window can be brought to front by pressing 
Alt+<digit>, where <digit> varies from 1 to 9, or clicking respective tab, which are placed 
above the area used to display the contents of the tab windows (see Fig. 85). 

 
Fig. 85 

The simulation settings are subdivided into three logical groups, each group located on 
a separate tab. The flow rates at reactor inlet(-s) are located on the Flow Rates tab, the 
operation conditions and additional process options are located on the Model Options 
tab, and the solver configuration information is located on the Solver Settings tab. The 
solver output is presented on the other four tabs. The principal results of the 
computations (the distributions of the material growth rate and AlN/GaN/InN fraction in 
the growth crystal over the substrate) are displayed on the Results tab. The distribution 
of the parasitic deposit growth rate over the ceiling and bottom is displayed on the 
Deposits tab (when available). The detailed results of the computations (the 2D 
distributions of the main process variables as well as instant growth rate and 
composition) are displayed on the 2D Results tab. The text output of the solver is 
displayed on the Output tab. A graphical representation of the text output is shown on 
the residuals charts on the Residuals and Specific Residuals tabs. 

4.5 Keyboard Shortcuts 

For faster access and user convenience frequently used operations have been assigned 
keyboard shortcuts, which are shown in the menus next to the menu items and in the 
hints shown over the toolbar buttons. The complete list of the keyboard shortcuts is as 
follows: 
 
New Simulation Ctrl+N 
Load Simulation Settings Ctrl+L 
Save Simulation Settings Ctrl+S 
Export .IN File … Ctrl+I 
Run Simulation Ctrl+Return 
Stop Simulation Ctrl+Del 
Save & Stop Simulation Ctrl+End 
Save & Continue Simulation Ctrl+Home 
Exit Ctrl+Q 
User Manual F1 
About Ctrl+A 
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Appendix A Hints on Solver Settings 

This section gives brief overview of the solver settings (see  3.4) and provides start 
values for modeling of different problems. The numbers within this section are just 
suggestions and should not be considered as the absolute limits. However, going below 
0.4 for the relaxation factors and above 0.6 for the inertial factors can be a sign of ill-
conditioned problem. 
 
There are two groups of solver settings controlling the solution process: the relaxation 
factors can be varied from 0 (strongest relaxation) to 1 (no relaxation), the inertial 
factors can be varied from 0 (no inertia) up to practical infinity (the larger inertial factor, 
the stronger inertia). 
 
Generally, the Planetary Reactor requires stronger relaxation and inertia, than the CCS 
reactors. Try starting AlGaN, AlN, and InGaN problems with 0.9–1.0 for the relaxation 
factors and 0–0.2 for the inertial factors for the CCS reactors; increase the range by 0.1 
for the Planetary Reactor. GaN exhibits stiffer volume chemistry and requires additional 
relaxation and/or inertia. Try increasing the inertial factor for the concentrations up to 
0.3–0.4 and decreasing respective relaxation factor down to 0.6–0.8.  
 
As account of material losses due to particle formation introduces rather stiff chemical 
process, it may require stronger relaxation/inertia for the concentrations. However, the 
relaxation value above 0.6 and the inertia value below 0.4 can usually do for the 
convergence. If the problem with particles fails to converge, try starting the computation 
for few hundred iterations with the Particles option turned off, then turn this option on 
and restart the computation. 
 
Final notes. If the problem converges well, try decreasing the inertial factors and/or 
increasing the relaxation factors beyond suggested values, as this can reduce 
computational time. If the problem diverges or does not converge, try increasing the 
inertial factors and/or decreasing the relaxation factors beyond suggested values (factor 
step about 0.02–0.1 is a good choice). Restarting the computations from a similar (same 
reactor and same material system) converging computation can solve some 
convergence issues as well.  
 
The user can also refer to the examples provided in the CVDSim distribution package 
(examples subfolder of the installation directory). 

Appendix B Reactor Geometries 

CCS Reactors  

There are three basic modifications of the close-coupled showerhead reactor, differing 
in the number of wafers carried by the susceptor: 3×2", 6×2", and 19×2" reactors. To 
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build up the geometries of the 6×2" and 19×2" reactors, we apply upscaling of the 3×2" 
reactor geometry published in [1]. The following basic reactor dimensions are given in 
[1]: the inlet to susceptor gap is 1.1 cm, the inlet showerhead diameter is 13 cm, the 
reactor diameter is 16.4 cm, and the susceptor diameter is 14.1 cm (see Fig. 86). It is 
also can be extracted from experimental radial dependencies of the deposition rate [1] 
that the inner edge of the ring of 2" wafers is located at about 0.6 cm from the susceptor 
center. 
 
To create the 19x2" reactor geometry, we have scaled up the 3x2" reactor dimensions 
in the following way: the proportion between the showerhead (inlet) and susceptor sizes 
was kept the same as in the 3x2" reactor, with the susceptor diameter being increased 
so that it would be suitable to load 19 two-inch wafers. 

 
Fig. 86. 2D geometrical model of the 3x2” close-coupled showerhead reactor. 

 
Fig. 87. General view of the 19x2” close-coupled showerhead reactor [2]. 

General view of the 19x2" reactor shown in Fig. 87 provides information on how the 
wafers are located on the wafer carrier: there is one 2" wafer placed at the susceptor 
center and two rings with 6 and 12 wafers. For each wafer ring, the following criterion 
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nshould be satisfied: 2 2R rπ ≥ ⋅ , where R is the coordinate of the wafer center, r is the 
wafer radius (5.08 cm), and n is the number of wafers in a wafer ring (see Fig. 88). From 
this equation, the center of the outer ring of wafers should be located farther than 9.7 
cm from the susceptor center, and the susceptor radius should be larger than 12.24 cm. 
At the same time, the susceptor radius should be larger than 5r (one central wafer and 
two rings of wafers), i.e. 12.7 cm. To avoid edge effects, some gap is required between 
the outer wafer edges and the susceptor edge. Moreover, this gap is well seen from Fig. 
87. Taking into account all these considerations, we consider the susceptor radius in the 
19x2" reactor to be 14 cm (12.7 cm +10%). Thus, the inlet showerhead radius is 12.9 
cm. The outlet channel width and the inlet-to-susceptor are taken to be the same as in 
the 3x2" reactor. 

 
Fig. 88. Schematic representation of the location of the wafers relative to the susceptor. 

The 6x2" reactor geometry was created in a similar way. In this case, the radius of the 
wafer ring should be larger than 4.85 cm, which means that the wafer ring starts at 
R=2.3 cm. We have taken this position to be 2.5 cm due to small gaps between wafers 
in the ring. The susceptor radius is taken to be 8.5 cm, and the inlet radius is 7.8 cm. 

Planetary Reactor 

The geometry for Aix 2000 HT Planetary Reactor was taken from the paper by 
Schineller et al [3]. In Fig.1 of this paper two plots of a vertical cross-section of the 
growth chamber are presented together with a schematic view of the 2 inch wafer. On 
the upper plot the outer chamber radius is related to the wafer length as 83/35, so it can 
be estimated as approximately 12 cm. The other reactor sizes can be extracted from the 
lower plot using the value of the outer radius and keeping the proportionality relations.  

 
Fig. 89. Top view of the Planetary Reactor® [4]. 
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On the Aixtron web site [4] there is a photograph with the top view of the Planetary 
Reactor (see Fig. 89), where one can observe a quartz disc placed in the center of the 
platform, whose radius can be estimated as about 1/3 of the outer radius, that is 
approximately 4 cm. This disk is included in the computational geometry presented in 
Fig. 90 as it may be at a lower temperature than the platform. 

 
Fig. 90. 2D geometrical model of the AIX 2000 HT Planetary Reactor. 

AIX 200/4 RF-S reactor 

The basic geometry for AIX 200/4 RF-S was taken from the paper by Yakovlev et al [5]. 
In Fig.3 of this paper a plot of a vertical cross-section of the growth chamber is 
presented. Additionally, extended supply tubes are used as presented in [6]. The 
susceptor discs are removed from the computational domain to simplify the 
computations. To avoid edge effects, some gap is required between the outer wafer 
edges and the susceptor edge, thus we consider the susceptor radius in the reactor to 
be 6.6 cm (5.08 cm +30%). Other reactor dimensions are scaled proportionally. 

 
Fig. 91. 2D geometrical model of the AIX 200/4 RS-S reactor. 
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